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CHAPTER 5 
 
 

Data Entry, Import and Export 
 
HEC-DSSVue has several components to enter data into HEC-DSS files.  
You can enter data manually, paste data from the clipboard into a data 
entry from, or import data from a variety of formats.  The formats include 
Microsoft Excel spreadsheet, the National Center for Climatic Data 
(NCDC), or directly from web pages, such as from the USGS NWIS 
database or the North Carolina CRONOS database. 
 
Most of the import functions are provided as "plug-ins".  Plug-ins are 
separate components that communicate with HEC-DSSVue and can be 
added, removed, or updated by the user.  Plug-ins are added or updated by 
simply copying the appropriate plug-in .jar file to the Plugins directory.  
Generally, a plug-in is accessible from a menu option and is not apparent 
to the user that a function is being provided by a plug-in instead of HEC-
DSSVue.  Plug-ins can be updated without having to update the HEC-
DSSVue program itself.  Refer to the HEC-DSSVue plug-ins web page for 
updates at:  http://www.hec.usace.army.mil/software/hec-dss/plug-ins.htm 
 
HEC-DSSVue can also import and store virtually any other kind of file in 
HEC-DSS files, including .jpg, .pdf, .doc, and .mp3 files.  When you select 
the pathname for a generic file and "plot" or "tabulate" the file, HEC-
DSSVue will launch the native application associated with the file 
extension.  For example, if you select a .doc file and then press the plot or 
tabulate button, Microsoft Word will be launched to read the file. 
 
You can also import files with the appropriate extension by simply 
"dragging and dropping" them from Windows Explorer onto HEC-
DSSVue with an open HEC-DSS file.  For example if you have SHEF 
data in a file with an extension name of ".shef", you can simply grab that 
file in Windows Explorer and drag it on top of HEC-DSSVue and it will 
be automatically imported. 
 
HEC-DSSVue can also export data to a variety of formats, depending on 
which plug-ins are loaded.  For example, if you have time-series data, you 
can select your pathnames.  From the HEC-DSSVue main window, from 
the Data Entry menu, point to Export, click SHEF.  From the Save 
browser choose the file you want to export to, and your data will be 
written in SHEF format to that file. 
 
Data Entry, Import and Export capabilities are accessible from the Data 
Entry menu. 
 

http://www.hec.usace.army.mil/software/hec-dss/plug-ins.htm�
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5.1 Entering Data Manually 

 
Time series data, paired data and text data can be manually entered using 
the Manual Data Entry Editors available from the Data Entry menu.  The 
following sections discuss all options in detail. 
 
 

5.1.1 Entering Time Series Data Manually 
 
To enter time series data manually: 
 
 1. From the Data Entry menu, click Manual Time Series.  The 

Time Series Data Entry dialog box will open (Figure 5.1). 
 

 
Figure 5.1  Time Series Data Entry Dialog Box 

 
 2. Type the Pathname Parts into the A, B, C, and F boxes, then 

select the appropriate time interval for the E box.  The complete 
pathname will automatically appear in the Pathname box.  
Alternatively, you can enter the pathname into the Pathname box  
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  and the parts will appear in the Pathname Parts boxes.  You 
cannot enter the "D" (date) part, as this is set according to your 
Start Date. 

 3. Enter the Start Date (e.g., 25Mar2002) and Start Time (e.g., 
1400). 

 4. Enter the Units (e.g., CFS). 
 5. From the Type list, select a data type.  Options are PER-AVER, 

PER-CUM, INST-VAL, and INST-CUM. 
 6. For regular interval time series data, the Date/Time cells in the 

table will fill automatically, starting with the start date and time 
you entered.  For irregular interval data, you will need to enter a 
date and time for each data value. 

 7. Type the data values into the Value column. 
 8. To view the data in plot form, click Plot. 
 9. To graphically edit the data you have entered, click Graphically 

Edit. 
 10. To save the new time series record, click Save. 
 
You can paste data on the clipboard from another application by clicking 
Paste.  This allows you to copy data from various applications like 
Microsoft Excel into HEC-DSS.  When you paste data into HEC-DSS, the 
tab characters and carriage return characters in the program that you are 
copying from must match the data entry table.  Tab characters move to the 
next column to the right, while carriage return characters move to the next 
row down.  These are the default characters used in Excel. 
 
For regular interval time series data, the data must be in a columnar format 
(e.g., a column from Microsoft Excel) and should contain data values 
only.  For irregular interval data, the date and time must precede each data 
value, with tab characters separating them.  For paired data, all values for 
each ordinate must be separated by a tab character.  To enter data using 
the paste capability: 
 
 1. Complete steps 1 through 5 above. 
 2. Select your data set from the other applications and Copy it to the 

clipboard. 
 3. Click Paste, you should see the data from the clipboard appear in 

the table. 
 
You can also automatically generate regular-interval time series data.  
This will fill in a single number for a time window.  To generate this data: 
 
 1. Complete steps 1 through 5 above. 
 2. Select the Automatic Generation tab. 
 3. Enter the End Date and End Time for the data. 
 4. Enter the Fill Value, which is the single value for the specified 

time window. 
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 5. Click Generate, this will return you to the Manual Entry tab, 
where you can plot, save, or further edit the data. 

 
 

5.1.2 Entering Paired Data Manually 
 
To enter paired data manually: 
 
 1. From the Data Entry menu, click Manual Paired Data.  The 

Manual Paired Data Entry dialog box dialog box (Figure 5.2) 
will open. 

 

 
Figure 5.2  Manual Paired Data Entry Dialog Box 

 
 2. Type the Pathname Parts into the A, B, C, D, E, and F boxes.  

The complete pathname will automatically appear in the 
Pathname box.  You can also enter the pathname into the 
Pathname box; the parts will appear in the Pathname Parts 
boxes.  Be sure the "C" part contains both an X parameter and a Y 
parameter, separated by a hyphen (e.g., STAGE-FLOW or ELEV-
DAMAGE). 
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 3. From the Number of Curves list select the number of curves to be 
entered.  Also, from Horizontal Axis, select X or Y. 

 4. In the X Units box, enter the units for X (belonging to the first 
parameter) and in the Y Units box, enter the units for Y (belonging 
to the second parameter). 

 5. From the X Type and Y Type lists, select the type for the 
respective parameters. Available options are Linear, Log, and 
Probability. 

 6. In the table, the Y parameter columns will split into individual 
columns according to the number of curves you specified. 

 7. Enter the data values into the X parameter and Y parameter 
columns. 

 8. To view the data in plot form, click Plot. 
 9. To save the new time series record, click Save. 
 
You can paste data on the clipboard from another application by clicking 
Paste.  This allows you to copy data from various applications like 
Microsoft Excel into HEC-DSS.  When you paste data into HEC-DSS, the 
tab characters and carriage return characters in the program that you are 
copying from must match the data entry table.  Tab characters move to the 
next column to the right, while carriage return characters move to the next 
row down.  These are the default characters used in Excel.  For paired 
data, all values for each ordinate must be separated by a tab character with 
a carriage return character at the end of each row.  To enter data using the 
paste capability: 
 
 1. Complete steps 1 through 6 above. 
 2. Select your data set from the other applications and Copy it to the 

clipboard. 
 3. Click Paste, you should see the data from the clipboard appear in 

the table. 
 
 

5.1.3 Manual Text Entry 
 
HEC-DSS has a text convention format.  You can enter data by manual 
text data entry and type or paste text into the text editor, or you can import 
a text file.  You cannot import text files into the HEC-DSS text format by 
dragging and dropping a .txt file; this will save a .txt file in the generic file 
format. 
 
To enter text data manually: 
 
 1. From the Data Entry menu, click Manual Text.  A dialog box 

will open (see Figure 5.3, page 5-6). 
 2. Type or paste the text data into the text dialog box.  You can 

change the font, but the font will not be stored with the text. 
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Figure 5.3  Dialog Box used to Enter Text 

 
 3. From the File menu you can insert a 

text file (.txt).  You can also save your 
text as a .txt file, save as an HEC-DSS 
file, or print your file (Figure 5.4).  You 
can also change the font of the text, but 
that will not be retained.  (Note:  You 
can also import text data directly from a 
.txt file from the HEC-DSSVue main 
window.  From the Date Entry menu, 
point to Import, click Text from File.) 

 4. After the text has been entered, click 
Save As to save the data to a DSS file.  
Also, from the File menu you can click 
Save or Save As to save the data as a 
DSS file.  Either method opens the Save As dialog box (Figure 
5.5). 

 

 
Figure 5.5  Save As Dialog Box 

 

Figure 5.4  File Menu 
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 5. Enter the Pathname Parts into the A, B, C, D, E, and F boxes.  
The complete pathname will automatically appear in the 
Pathname box.  You can also enter the pathname into the 
Pathname box; the parts will appear in the Pathname Parts boxes 
(see Figure 5.5, page 5-6). 

 6. To save the record, click OK. 
 
 

5.2 Import/Export Files 
 
You can import and export text files, image files and other types of files 
into HEC-DSS files from the Import or Export menu items on the Data 
Entry menu. 
 
 

5.2.1 Import Text Files 
 
HEC-DSS has a text convention format.  You can enter data by manual 
text data entry and type or paste text into the text editor, or you can import 
a text file.  You cannot import text files into the HEC-DSS text format by 
dragging and dropping a .txt file; this will save a .txt file in the generic file 
format. 
 
To import a text file: 
 
 1. From the Data Entry menu, point to Import, click Text from 

File. 
 2. An Open browser will be open (Figure 5.6).  Navigate to the 

directory and file you wish to import.  Select the file and click 
Open, you can only import non-formatted regular text. 

 

 
Figure 5.6  Open Browser 
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 3. A dialog box will open (Figure 5.7) displaying the contents for the 
selected file.  You can make any changes you want to the text. 

 

 
Figure 5.7  Dialog Box for Importing Text 

 
 4. After the text has been entered, click Save As to save the data to a 

DSS file.  Also, from the File menu you can click Save or Save As 
to save the data as a DSS file.  Either method opens the Save As 
dialog box (see Figure 5.5, page 5-6). 

 5. Enter the Pathname Parts into the A, B, C, D, E, and F boxes.  
The complete pathname will automatically appear in the 
Pathname box.  You can also enter the pathname into the 
Pathname box; the parts will appear in the Pathname Parts boxes 
(see Figure 5.5, page 5-6). 

 6. To save the record, click OK. 
 
 

5.2.2 Exporting Text Files 
 
To export to a text file: 
 
 1. You can export data to a text file by selecting the pathname for the 

data set that you want to export, from the Data Entry menu, point 
to Export, click Export to File(s).  You can only export one text 
data set at a time for this convention.  (For image and generic files 
you can export several at one time.)  This menu option will only 
appear for text, image and generic files. 

 2. A Save browser will open (see Figure 5.8, page 5-9).  Navigate to 
the directory where you want the file saved, in the File name box 
enter the name of the file, and click Save. 

 
 

5.2.3 Import Image and Generic Files 
 
HEC-DSS has a convention for storing image (photos, etc.) and other files 
in a generic file format.  For this format, the pathname will have a C part  
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Figure 5.8  Save Browser 
 
that is the name of the file (without directory), a D part that is either 
"IMAGE" or "FILE", and an E part that is the extension of the file (e.g., 
"JPG" or "PDF").  For more information, refer to Chapter 1, Section 
1.2.3. 
 
When you select images or files (generic type) in HEC-DSSVue and select 
either “plot" or "tabulate", HEC-DSSVue will launch a photo viewer for 
image data, or launch the application associated for that file type.  For 
example, if the file type is ".pdf", HEC-DSSVue will launch Adobe 
Acrobat with a copy of that file loaded into it. 
 
The easiest way to import both image and generic files is to drag them 
from Windows Explorer and drop them into the main screen of HEC-
DSSVue with an opened HEC-DSS file.  A Save As dialog box will open 
(see Figure 5.5, page 5-6) where you can enter the pathname parts.  You 
can also import images and generic files from the Data Entry menu. 
 
To import image or generic files into HEC-DSS: 
 
 1. From the Data Entry menu, point to Import, either click Images 

or Files (Generic type). 
 2. An Open browser will open (see Figure 5.9, page 5-10).  Navigate 

to the directory and select the files you wish to import.  Select the 
files and click Open.  You can import multiple files at one time. 

 3. The Save As dialog box will open (see Figure 5.5, page 5-6).  
Enter the Pathname Parts into the A, B, and F boxes.  The 
complete pathname will automatically appear in the Pathname 
box.  You can also enter the pathname into the Pathname box; the  
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Figure 5.9  Open Browser – Importing Images and Generic Files 

 
  parts will appear in the Pathname Parts boxes (see Figure 5.5, 

page 5-6). 
 4. To save the records, click OK. A confirmation window will 

appear, see Figure 5.10. 
 

 
Figure 5.10  Save Files Confirmed 

 
Or, alternatively you can import image and generic files by: 
 
 5. From Windows Explorer (Figure 5.11), select the files that you 

wish to import. 
 

 
Figure 5.11  Example of Data Selection for Drag and Drop 
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 6. "Drag" the files onto the main HEC-DSSVue screen (with a HEC-
DSS file open). 

 7. The Save As dialog box will open (see Figure 5.5, page 5-6).  
Enter the Pathname Parts into the A, B, and F boxes.  The 
complete pathname will automatically appear in the Pathname 
box.  You can also enter the pathname into the Pathname box; the 
parts will appear in the Pathname Parts boxes. 

 8. To save the records, click OK, a message window will open (see 
Figure 5.10, page 5-10). 

 9. The actual file names will be displayed in the C part, as shown in 
Figure 5.12. 

 

 
Figure 5.12  Imported Filenames Located in the C Part 

 
 

5.2.4 Exporting Image and Generic Files 
 
You can export image and generic files by: 
 
 1. Select the pathnames for the data sets that you want to export, from 

the Data Entry menu, point to Export, click Export to File(s). 
 2. A Save browser will open (see Figure 5.8, page 5-9); navigate to 

the directory you want to save the file, click Save.  The images or 
files will be saved with their original names.  A confirmation 
window will open (Figure 5.13). 

 

 
Figure 5.13  Saving Files Confirmation 
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5.3 Importing and Exporting SHEF Data 

 
The Standard Hydrologic Exchange Format (SHEF) is a text based format 
developed by the National Weather Service (NWS) for exchange of real 
time operational data with other agencies.  SHEF was adopted by mutual 
agreement for exchange of data between NWS and the Corps of 
Engineers.   
 
The import/export SHEF features are complied into HEC-DSSVue; they 
are not plug-ins and cannot be updated or removed from the program. 
 
 

5.3.1 SHEF Table Files 
 
The implementation of the import and export of SHEF data in HEC-
DSSVue is based on the prior existing programs SHFDSS and DSSSHF.  
These programs, and their implementation in HEC-DSSVue, use three 
reference tables: one for defining SHEF parameter codes (SHEFPARAM), 
one for relating SHEF physical element (PE) codes to DSS parameters 
(shfdssp), and one for relating station identifiers to observation frequencies 
and pathname parts (shfdsss).  These files are required to access the 
import/export capability; sample files are distributed with HEC-DSSVue. 
 
The SHEF sample table files are distributed with HEC-DSSVue and stored 
in the users application directory under HEC-DSSVue (the location of the 
application directory is dependent on the operating system).  You can 
browse to these files and edit the files, from the Advanced menu, click 
Program Options, the Options dialog box will open (Figure 5.14).  Click 
the SHEF tab, information from the dialog box will show the location of 
the SHEF sample table files.  If you have existing files from SHFDSS, you 
can use those in HEC-DSSVue. 
 

 
Figure 5.14  Options Dialog Box – SHEF Tab 
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 SHEFPARM 
 
The SHEFPARM file contains SHEF PE (Physical Element) codes and the 
metric - English conversion factor.  Generally, the supplied file should be 
sufficient unless newer PE codes are being used.  To edit the SHEFPARM 
file, from the Options dialog box, with the SHEF tab clicked (see Figure 
5.14, page 5-12), click Edit that is next to the ShefParm File box.  A 
dialog box will open (Figure 5.15), which will allow the user to edit the 
SHEFPARM file.   In this table, the first column contains the PE code and 
the second column contains the Metric to English conversion factor, if 
there is no factor, set this cell to 1.0. 
 

 
Figure 5.15  SHEFPARM File Dialog Box 
 

 Parameter File – shfdssp 
 
The parameter file links the HEC-DSS "C" part (the parameter), the data 
units, and type to the SHEF parameter (PE).  To edit the parameter file, 
from the Options dialog box, with the SHEF tab clicked (see Figure 5.14, 
page 5-12), click Edit that is next to the Parameter File box.  The SHEF 
Parameter File dialog box will open (Figure 5.16), which will allow the 
user to edit the parameter file.  From the SHEF PE Code column of the  
 

 
Figure 5.16  SHEF Parameter File Dialog Box 
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table edit the PE code; from the Part C column (see Figure 5.15, page  
5-13) edit the C Part of the DSS pathname, the units for the PE code can 
be edited in the Units column, the type of for the PE code can be edited in 
the Type column, and from the Factor column, an optional factor to 
multiply the data by (e.g., kilo-cfs might have a factor of 1000.0 and store 
the data in HEC-DSS as cfs) can be entered.  The sample parameter file 
that is distributed with HEC-DSSVue should be relatively complete. 
 
 

 Sensor File – shfdsss 
 
The SHEF sensor file links the SHEF gage ID to the HEC-DSS A, B, and 
F parts.  To edit the parameter file, from the Options dialog box, with the 
SHEF tab clicked (see Figure 5.14, page 5-12), click Edit that is next to 
the Sensor File box.  The SHEF Sensor File dialog box will open (Figure 
5.17), which will allow the user to edit the sensor file.  For each Gage ID 
and PE code, a row should exist with the Gage ID in column 1, the PE  
 

 
Figure 5.17  SHEF Sensor File Dialog Box 
 
code in column 2, an optional time interval in column 3, the A part (basin) 
in column 4, the B part (location) in column 5, and the F part (version) in 
column 6.  If no time interval is given, the data interval is assumed to be 
irregular.  If a time interval is provided, is should end with "M" for 
minutes (e.g. 15M), or "H" for hours (e.g., 6H).  If an entry does not exist 
for the data type being imported, default values are used. 
 
 

5.3.2 Importing SHEF Data 
 
Once the SHEF tables are setup, you can import SHEF data by either 
dragging SHEF files with an extension of ".shef" or “".shf" from Windows 
Explorer and dropping them into the main screen of HEC-DSSVue with 
an open HEC-DSS file or from the Data Entry menu. 
 
To import SHEF data files into HEC-DSS: 
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 1. From the Data Entry menu, point to Import, click SHEF. 
 2. An Open browser will open (see Figure 5.6, page 5-7), navigate to 

a directory and select the files you wish to import.  Select the files 
to import, click Open.  You can import multiple files at one time.  
The file extensions do not matter for this option (the files do not 
need to end with “.shef"). 

 3. A message window will open (Figure 5.18); this window will 
display how many values were stored from the SHEF data sets.  
You can view the SHEF process log by clicking View Log. 

 

 
Figure 5.18  SHEF Import Status Message Window 

 
Or, alternatively you can import SHEF files if they have the extension 
".shef" or ".shf" by: 
 
 1. From Windows Explorer, select the ".shf" or ".shef" files that you 

wish to import (Figure 5.19). 
 

 
Figure 5.19  Selection of .shf or .shef Files to Drag and Drop into DSSVue 

 
 2. "Drag" the files onto the main HEC-DSSVue screen (with your 

HEC-DSS file that you want to import to opened.) 
 3. The data is imported and a message window will open (Figure 

5.18), this window will display how many values were stored from 
the SHEF data sets.  You can view the SHEF process log by 
clicking View Log. 
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5.3.3 Exporting SHEF 

 
You can export SHEF data by: 
 
 1. Select the pathnames for the data sets that you want to export, then 

from the Data Entry menu, point to Export, click SHEF. 
 2. A Save browser will be open (Figure 5.20), navigate to the 

directory where you want the exported SHEF data to be, type the 
name of file in the File name box, click Save.  All data will be 
saved in one file. 

 

 
Figure 5.20  Save Browser - SHEF Data 

 
 

5.4 Importing and Exporting Microsoft Excel and ".csv" 
Data 

 
Importing, exporting and editing data with Microsoft Excel is 
accomplished in HEC-DSSVue by the "plug-in Excel.jar", stored in the 
HEC-DSSVue Plugins directory.  Plug-ins can be updated without having 
to update the HEC-DSSVue program itself.  Refer to the HEC-DSSVue 
plug-ins web page for updates at:  
http://www.hec.usace.army.mil/software/hec-dss/plug-ins.htm. 
 
At this time, only time-series data can be imported into HEC-DSS.  Check 
the web site above for updates.  Both time series and paired data can be 
exported to Excel but only time-series data can be edited in Excel. 
 

http://www.hec.usace.army.mil/software/hec-dss/plug-ins.htm�
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You can also import time-series data in a comma separated format (.csv) 
or data separated by blank spaces, using the same procedure with the 
"Time Series Wizard".  This plug-in is in a development stage; check the 
plug-ins web page for updates. 
 
Note:  Excel uses beginning of period dates, whereas HEC-DSS uses end 
of period.  Thus, the average data for a day will show at 0000 hours in 
Excel and 2400 hours in HEC-DSS.  This can cause a time shift by a day 
if the data is not imported or exported carefully; Check your data after the 
operation.  You can shift data to the correct times by using the Time 
Functions tab in the Math Functions screen. 
 
 

5.4.1 Exporting Data to Microsoft Excel 
 
To export data to Excel, simply select the data sets you want to export and 
then press the Excel Icon      on the tool bar, or from the Display menu, 
click Tabulate in Excel.  An example of data tabulated in Excel is shown 
in Figure 5.21.  You can then save the Excel file to the name that you 
desire.  Currently you cannot format the data in a different manner. 
 

 
Figure 5.21  Tabulating Data in Excel 
 
If the Excel icon is not displayed, then you need to download the Excel.jar 
file from the web page listed above and save it in the HEC-DSSVue\ 
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Plugins directory.  This capability assumes that you have Microsoft Excel 
loaded on your computer or another program that is associated with ".xls" 
files. 
 
 

5.4.2 Editing Data in Microsoft Excel 
 
You can edit data in Microsoft Excel by selecting the pathnames that need 
to be edited. From the Edit menu, click Edit in Excel, an Excel Data 
dialog box will open (Figure 5.22), as well as Microsoft Excel.  The data 
associated with the selected pathnames will be display in the spreadsheet.   
 

 
Figure 5.22  Excel Data Dialog Box 
 
After you have made your changes, save the Excel file, and close 
Microsoft Excel.  From the Excel Data dialog box click OK, the dialog 
box will close and the edits made to the data for those selected pathnames 
will be stored in the DSS file.  If you do not want to save your changes 
back to HEC-DSS, click Cancel. 
 
Note:  You can only change data in Excel when you are editing - you 
cannot add or delete data.  The data must remain in the same format with 
the same number of rows and columns to be stored back to HEC-DSS. 
 
 

5.4.3 Importing Data from Microsoft Excel or ".csv" files 
using Data Entry 

 
You can import time-series data from Excel, a ".csv" file, or a blank 
separated file using the Data Entry dialog box.  At this time, you can only 
import time-series data (both regular interval and irregular interval data).  
Check the HEC-DSSVue plug-ins web page for updates. 
 
 1. From the HEC-DSSVue main window open a DSS file, from the 

Data Entry menu, point to Import, click Excel (see Figure 5.23, 
page 5-18). 

 2. If your data is in a ".csv" or blank separated file, select Time 
Series Data instead of Excel. An example of the browsing window 
is shown in Figure 5.24 (page 5-18). 
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Figure 5.23  Importing Excel or .csv Files 

 

 
Figure 5.24  Selection of an Excel or .csv File to import into HEC-DSSVue 

 
 3. Select your file to import.  Data should be in columns, separated by 

comma or spaces.  Ideally, a row should contain a location or 
parameter, and a column should contain date/time. 

 4. The file will be read into an editable table as shown in Figure 5.25 
(page 5-20). 

 5. For regular-interval time series data, select the column cells that 
you wish to import.  For irregular-interval data, you need to select 
date/time column cells also. 
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Figure 5.25  Editable Import Table of an Excel or .csv File 
 

 6. Press the Import button and your selected cells will be entered 
into the time series data entry dialog, as shown in Figure 5.26. 

 

 
Figure 5.26  Selecting and Importing Data 

 
 7. Enter the pathname parts, units and type, and then press Save.  An 

example of the Time Series Data Entry window that appears after 
data have been imported is shown in Figure 5.27 (page 5-21). 
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Figure 5.27  Time Series Data Entry Dialog Box 

 
Note:  Excel uses beginning of period dates, whereas HEC-DSS uses end 
of period.  Thus, the average data for a day will show at 0000 hours in 
Excel and 2400 hours in HEC-DSS.  This can cause a time shift by a day 
if the data is not imported or exported carefully; Check your data after the 
operation.  You can shift data to the correct times by using the Time 
Functions tab in the Math Functions screen. 
 
 

5.4.4 Importing Data from Microsoft Excel or ".csv" files 
using Time Series Wizard 

 
You can import multiple columns of time-series data from Excel, a ".csv" 
file, or a blank separated file using the Time Series Wizard.  The Time 
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Series Wizard is a plug-in that is distributed in a development stage; 
check the HEC-DSSVue plug-ins web page for updates. 
 
 1. Open your DSS file from the Data Entry men, point to Import, 

click and click Excel (see Figure 5.23, page 5-19). 
 2. If your data is in a ".csv" or blank separated file, click Time Series 

Data instead of Excel. 
 3. Select your file to import (see Figure 5.24, page 5-19).  Data 

should be in columns, separated by comma or spaces.  Ideally, a 
row should contain a location or parameter, and a column should 
contain date/time. 

 4. The file will be read into an editable table as shown in Figure 5.25 
(page 5-20). 

 5. Select any location, parameter, units, or version, etc. rows by right 
clicking on the header row in the first column and selecting the 
item, as shown in Figure 5.28.  You may also skip any rows that 
are not to be imported or used. 

 

 
Figure 5.28  Assigning Locations, Parameters, Units, Versions, etc. to Rows 

 
 6. From the top header row, select any columns that contain dates or 

times, as shown in Figure 5.29 (page 5-23). 
 7. You can also select individual data columns from the header 

popup. 
 8. Alternatively, you can enter all data into DSS at one time by right-

clicking the upper left cell and selecting Set All Data Columns, as 
shown in Figure 5.30 (page 5-23).  The resulting window will look 
like the example in Figure 5.31 (page 5-24). 
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Figure 5.29  Assigning Data and Time to Columns 

 

 
Figure 5.30  Select all Data and Columns to Import 

 
 9. This will bring up a dialog to set additional pathname parts or 

units, as shown in Figure 5.32 (page 5-24). 
 10. Enter additional information desired.  To import all the data sets, 

click Import Now.  A confirmation window will appear, see 
Figure 5.33 (page 5-24). 

 11. Alternatively, if all columns are not to be imported, individual data 
set columns can be imported by right clicking on the header row of  
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Figure 5.31  Window after Selecting Select All Data Columns 

 

 
Figure 5.32  Import Data Window 

 

 
Figure 5.33  Import Data Confirmation Window 

 
  the column and selecting Set Data Column. This will bring up the 

window shown in Figure 5.32. 



HEC-DSSVue User's Manual Chapter 5 – Data Entry, Import & Export 

5-25 

 12. Fill in the additional information and click Import Now if you are 
finished importing data from this file, or click OK to select other 
columns.  When you have selected all the columns you want to 
import, click Import Now, or click Import at the bottom of the 
table.  A confirmation window will appear (see Figure 5.33, page 
5-24). 

 
 

5.5 Retrieving and Importing USGS (NWIS) Data 
 
You can retrieve and import time-series data from the USGS NWIS 
database via the web using the USGS plug-in tool.  The USGS 
occasionally updates the NWS database with more information and the 
USGS plug-in may be updated to reflect changes; check the HEC-
DSSVue plug-ins web page for updates. 
 
The USGS data retrieval plug-in will retrieve daily, hourly and annual 
peak flows from the NWIS web site.  Daily, real-time and peak data 
availability can be obtained from the USGS water web site at:  
http://waterdata.usgs.gov/nwis.  Hourly data information can be obtained 
from the USGS IDA (Instantaneous Data Archive) at 
http://ida.water.usgs.gov.  The IDA is in a developmental phase and only a 
limited number of stations have historical short-term data available. 
 
To use the USGS plug-in, you must be connected to the internet and the 
file USGS.jar must be located in the Plugins directory for HEC-DSSVue. 
 
 1. Open your DSS file, from the Data Entry menu, point to Import, 

click USGS Web.  This will open the USGS Download plug-in 
interface with an empty station identifier table. 

 2. You can either open a previously saved table, manually enter the 
station information for the stations that you want, or automatically 
populate the table with a list of stations available on a state by state 
basis. An example of the USGS Download window can be seen in 
Figure 5.34. 

 

 
Figure 5.34  USGS Download Window 

http://waterdata.usgs.gov/nwis�
http://ida.water.usgs.gov/�
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 3. To open a previously saved table, from the File menu, click Open 

Station Table.  Browse to the directory and file that you want to 
access and then click Open.  Optionally, you can select a file from 
the most recently used file list at the bottom of the File menu.  To 
save a table, from the File menu, click Save Station Table.  
Browse to the directory where you want to save your table and 
then enter the file name and click Save.  Tables are in text format 
and are saved with an extension of ".usgs". 

 4. To manually enter station information, select the USGS Station ID 
cell on a blank row.  Enter the USGS station ID number and then 
fill in the basin or river name, location name, parameter and 
version in the subsequent columns or accept the defaults provided 
after entering the station ID.  If you need to add additional rows, 
select the Edit menu and then Insert Rows.  Fill in the identifiers 
for any remaining stations that you want.  Once you have 
completed your table, save it using Save Station Table from the 
File menu. 

 5. You can sort the station table by pressing on the column header of 
the column that you want to sort by.  A second press of the column 
header will perform an inverse sort. 

 6. You may find the list of stations easier to use if you delete those 
stations that you are not interested in.  To do this, highlight the 
rows in the table that you want to delete and then select Delete 
Checked Rows from the Edit menu.  You can save your table by 
selecting Save Station Table from the File menu. 

 7. You can query for the starting date and ending date of available 
data for selected stations.  To do this, select the check boxes for the 
stations that you want and then press the Get Available Dates 
button.  Each station has to be queried independently, so select 
only those stations that you are interested in.  The date range for 
the selected stations will be displayed in the two right most 
columns of the table. 

 8. To retrieve data from the USGS web site and import into HEC-
DSS, select the Data Type you want (either Daily, Instantaneous 
(Hourly), Real Time or Annual Peak Data) from the drop down 
selector near the top panel of the screen.  If you want daily, you 
can enter a start date and end date for the time frame that you are 
interested in or select the Retrieve Period of Record check box to 
retrieve the period of record data.  The date should be entered in 
the form of DDMMMYYYY (e.g., 03FEB2005).  Selecting the 
small box in the date field will provide a calendar tool to aid in 
setting the date.  Even though you may specify dates, only data that 
is available within those dates from the web site can be retrieved.  
If you want real time data, enter the number of days back that you 
want to retrieve data for.  The USGS offers data for the last thrity-
one days for real time data. 
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 9. Use caution when selecting a time period for instantaneous 
historical data, as you might unintentionally request excessive 
number of values.  For example, if data is given in 15 minute 
intervals, a year's worth of data will be 35,040 values, which can 
take a long time to retrieve. 

 10. After the data type and time span have been set, select the stations 
from the table that you want data for by checking the box in the 
Import Data column for those stations.  If you want to retrieve 
data for all stations in your table, press the Select All button.  The 
data retrieval process will begin when you press the Import 
button.  This operation will take some time, depending on your 
connection speed to the internet and how much data you have 
requested.  A Retrieve Progress dialog box will display the 
progress of the process.  After data has been retrieved, the main 
catalog screen in HEC-DSSVue will be automatically updated. 

 11. Daily data is stored with an E part of "1DAY".  The interval for 
real-time data will be set based on the frequency of the data 
retrieved.  If the frequency varies, the data will be store in an 
irregular interval format.  You may want to use the interval 
modification functions available from the Time Functions tab in 
the Math Functions screen to change the data to a desired interval. 

 12. Data can be directly plotted, tabulated or sent to Microsoft Excel 
from the plug-in by selecting the desired data sets and then 
pressing the appropriate tool bar button.  You do not need to 
import the data first; it will be automatically imported and stored in 
the HEC-DSS file for you.  To send the data to Microsoft Excel, 
you must have installed the Excel plug-in, available from the HEC-
DSSVue plug-in web page, or you must have an Excel capable 
version (currently under development) of the program. 

 13. Some offices require proxy information to be set to access the 
internet.  Proxy information can be set by selecting the Options 
item from the Edit menu.  This will display the screen shown in 
Figure 5.35.  Fill in the appropriate values and then click OK.  The 
information will be retained between sessions. 

 

 
Figure 5.35  Connection Settings Dialog Box 
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 14. The USGS plug-in currently has limited error detection 
capabilities.  If you think that there are problems, you should check 
the HEC-DSSVue log screen for messages.  The log screen is 
usually minimized in your task bar.   

 
  The USGS plug-in will indicate when data cannot be retrieved, but 

it may not give the reason why.  You should check the USGS web 
page with a browser to ensure that what you are requesting is 
available.  The web address is:  http://waterdata.usgs.gov/nwis for 
daily and real-time data, or http://ida.water.usgs.gov/ida for hourly 
data. 

 
 

5.6 Importing NCDC Data 
 
You can optionally import climatic data from the National Climatic Data 
Center using the NCDC plug-in tool.  It cannot retrieve data from NCDC; 
NCDC provides climatic data via ftp.  This tool will import data in the ftp 
file that you received. 
 
The NCDC data import plug-in will import data in the following formats:  
3200 and 3210 (Daily Climatic Data), 3220 (Monthly Surface Data), 3240 
(Hourly Precipitation Data), 3260 (15-minute precipitation data), LCD and 
3505 (Local Climatic Data), and the GSOD (Global Surface Summary of 
Day).  The plug-in will import all data from the data file provided using 
default names and units.  Users may want to rename parts of pathname 
and/or delete unwanted data sets. 
 
 

5.6.1 Obtaining NCDC Data 
 
Data can be obtained via an ftp download from the NCDC web site at: 
http://www.ncdc.noaa.gov/oa/ncdc.html.  The 3240 data is found at the 
address: 
http://ols.nndc.noaa.gov/plolstore/plsql/olstore.prodspecific?prodnum=C0
0313-TAP-A0001. 
 
You can obtain a list of the available stations (near the bottom of the page) 
after you click the link in the page above to enter the NCDC store.  We 
have found it more useful to select stations in the county you are interested 
in and allow it to return the data that it has.  To do this, select the Country.  
In that page, select the state and then select Counties and then select your 
county(ies) and the date range that you are interested in.  We recommend a 
comma delimited format with station name. 
 
Check the "Inventory Review" box, enter your email address and then 
press "Submit Request".  The server will generate a data file and email 

http://waterdata.usgs.gov/nwis�
http://ida.water.usgs.gov/ida�
http://www.ncdc.noaa.gov/oa/ncdc.html�
http://ols.nndc.noaa.gov/plolstore/plsql/olstore.prodspecific?prodnum=C00313-TAP-A0001�
http://ols.nndc.noaa.gov/plolstore/plsql/olstore.prodspecific?prodnum=C00313-TAP-A0001�
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you when it is ready.  Click on the link in your email (or the one in the last 
page you were on, if you waited long enough).  This should display the 
data file in your internet browser.  Save this file to disk and select it from 
the NCDC import plug-in.  The plug-in will remove any of the html 
format that might be present.  Data may be free for some government and 
educational internet addresses. 
 
 

5.6.2 Recognized NCDC Formats 
 
The plug-in has been tested with NCDC 3200, 3210, 3220, 3240 and 3260 
formats in all forms.  It has also been tested with LCD, GSOD and 3505 
delimited formats.  It will not import data from non-delimited LCD, 
GSOD and 3505 formats.  If you have a choice for your format, we 
recommend comma delimited with station names. Many of the parameter 
types in 3200, 3220, LCD, GSOD and 3505 formats do not have the units 
or type assigned by the importer and they may need to be edited in later, if 
needed. 
 
Examples of these formats are: 
 
 1. 3240 Comma Delimited: 
 

COOPID,CD,ELEM,UN,YEAR,MO,DA,TIME,HOUR01,F,F,TIME,HOUR02… 
------,--,----,--,----,--,--,----,------,-,-,----,------ 
041112,00,HPCP,HI,1970,09,01,0100, 00000,g, ,0200, 00000,…  
041112,00,HPCP,HI,1970,09,04,0100, 00000, , ,0200, 00000,… 
041112,00,HPCP,HI,1970,10,01,0100, 00000,g, ,0200, 00000,…  
… 

 
 2. 3240 Space Delimited with Station Name: 
 

COOPID STATION NAME                   CD ELEM UN YEAR MO DA TIME 
HOUR01 
------ ------------------------------ -- ---- -- ---- -- -- ---- --
----041112 BROOKS FARNHAM RANCH           00 HPCP HI 1970 09 01 
0100  00000 
041112 BROOKS FARNHAM RANCH           00 HPCP HI 1970 09 04 0100  
00000 041112 BROOKS FARNHAM RANCH           00 HPCP HI 1970 10 01 
0100  00000 
… 

 
 3. 3240 fixed: 
 

HPD04111200HPCPHI19700900010010100 00000g  
HPD04111200HPCPHI19700900010012500 00000   
HPD04111200HPCPHI19700900040011900 00005   
HPD04111200HPCPHI19700900040012500 00005   
HPD04111200HPCPHI19701000010010100 00000g  

 
 4. 3240 variable: 
 

HPD04111200HPCPHI19701000010020100 00000g 2500 00000   
HPD04111200HPCPHI19701000180080400 00003  0500 00010  0600 00012  
HPD04111200HPCPHI19701000200030100 99999[ 1200 99999] 2500 00000I 
… 
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 5. 3260 Comma Delimited with Station Name and html headings: 
 

<META http-equiv=Content-Type content="text/html; charset=utf-
8"></HEAD> 
<BODY><PRE>COOPID,STATION NAME                  
,CD,ELEM,UN,YEAR,MO,DA,TIME, VALUE,F,F 
------,------------------------------,--,----,--,----,--,--,----,--
----,-,- 
040897,BLUE CANYON                   ,00,QPCP,HI,1985,08,01,0015, 
00000,g,  
040897,BLUE CANYON                   ,00,QPCP,HI,1985,08,01,2500, 
00000, ,  
040897,BLUE CANYON                   ,00,QPCP,HI,1985,08,17,1500, 
00003, ,  
040897,BLUE CANYON                   ,00,QPCP,HI,1985,08,17,1600, 
00008, , 

 
 6. 3260 Variable with html headings: 
 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN"> 
<HTML><HEAD> 
<META http-equiv=Content-Type content="text/html; charset=utf-
8"></HEAD> 
<BODY><PRE>15M04089700QPCPHI19850800010020015 00000g 2500 00000   
15M04089700QPCPHI19850800170041500 00003  1600 00008  1700 00002  
2500 00013   
15M04089700QPCPHI19850800290051700 00004  1800 00011  1900 00003  
2000 00002  2500 00020   
15M04089700QPCPHI19850800300021200 00001  2500 00001   
15M04089700QPCPHI19850900010020015 00000g 2500 00000   

 
 7. 3260 Fixed with html headings: 
 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN"> 
<HTML><HEAD> 
<META http-equiv=Content-Type content="text/html; charset=utf-
8"></HEAD> 
<BODY><PRE>15M04089700QPCPHI19850800010020015 00000g  
15M04089700QPCPHI19850800010022500 00000   
15M04089700QPCPHI19850800170041500 00003   
15M04089700QPCPHI19850800170041600 00008   
15M04089700QPCPHI19850800170041700 00002 

 
 8. 3200 Delimited: 
 

COOPID,WBANID,Prelim,year,month,day,Tmax,Tmin,Tobs,Tmean,Cdd,Hdd,Pr
cp,Flag 
042294,99999, ,1989,12,29,56,37,46,47,0,18,0, ,0, ,0 
042294,99999, ,1989,12,30,65,33,37,49,0,16,0, ,0, ,0 
042294,99999, ,1989,12,31,52,30,32,41,0,24,0, ,0, 
,0,42.8,53.0,32.6,65,25,0,636,0.03,0   

 
 9. 3200 Fixed: 
 

DLY29002201SNWD I19480399990310118 00005 10218 00005 10318 00012 
10418 00016 10518 00016 
DLY29002201DYSWNA19480499990310199-99999M 0218 01100 10318 01100 
10499-99999M 0518 01100   DLY29002201PRCPHI19480499990310118 00000 
10218 00000 10318 00000 10418 00000 10518 00000   
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 10. 3210 Fixed: 
 

DLY00003017F2MNMD200401A1990310124 21018 00224 04020 00324 13023 
00424 31018 00524 DLY00003017F5SCMD200401A1990310124 21023 00224 
05022 00324 13025 00424 31022 00524   
DLY00003017FMTMHR200401A1990310124 01810 00224 01258 00324 01341 
00424 01551 00524   

 
 11. 3210 Fixed: 
 

MLY04111202CLDD D19859999990060100 00000  0200 00003  0300 00000  
0400 00032B MLY04111202DP01NA19859999990060100 00002  0200 00002  
0300 00008  0400 00000  MLY04111202DP05NA19859999990060100 00000  
0200 00001  0300 00001  0400 00000   

 
 12. 3220 Delimited: 
 

COOPID,WBNID,CD,ELEM,UN,YEAR,A,S,MO,DA,  JAN ,F,F,MO,DA,  FEB 
,F,F,MO,DA,  MAR  
------,-----,--,----,--,----,-,-,--,--,------,-,-,--,--,------,-,-
,--,--,------041112,99999,02,CLDD, D,1985,9,9,01,00, 00000, , 
,02,00, 00003, , ,03,00, 00000  
041112,99999,02,DP01,NA,1985,9,9,01,00, 00002, , ,02,00, 00002, , 
,03,00, 00008 

 
 13. LCD Delimited: 
 

Month:, 12/2004 
Station Name:, "LOS ANGELES INTERNATIONAL AIRPORT" Call Sign:, LAX 
Day,Time,StationType,Maint Indic,SkyConditions,Visibility,Weather 
Type,Dry Bulb 01,0050,AO2 ,-,CLR ,10SM   ,-,46   ,   7.8,40   ,   
4.3,31   ,   -.6, 56 , 3   ,VRB,-, 01,0150,AO2 ,-,CLR ,10SM   ,-,46   
,   7.8,38   ,   3.5,27   ,  -2.8, 47 , 0   ,000,-, 01,0250,AO2 ,-
,CLR ,10SM   ,-,45   ,   7.2,36   ,   2.3,22   ,  -5.6, 40 , 5   
,010,-,  

 
 14. LCD Delimited: 
 

Month:,09/2002 
Station Name:, ASHEVILLE REGIONAL AIRPORT (AVL) 
DT,Hr1, Hr2, Hr3, Hr4, Hr5, Hr6, Hr7, Hr8, Hr9, Hr10, Hr11, Hr12, 
Hr13, Hr14, Hr15,  
1,----,----,T   ,----,----,----,----,----,----,----,----,----,----
,----,----,----,---- 
15,.05,.02,.03,.06,.01,.02,.02,T   ,.01,T   
,.02,.09,.06,.02,.04,.05,.01,T   ,.01,T   
---,----,----,----,----,----,----,----,----,----,----,----,----,---
-,----,----,----  

 
 15. GSOD Delimited: 
 

STN---  YEARMODA    TEMP       DEWP      SLP        STP       VISIB      
WDSP     MXSPD   010010  20000501    33.2  8    29.9  8  1013.4  8  
1012.3  8    8.6  6    4.5  8   13.0  010010  20000502    29.4  8    
26.5  8  1015.0  8  1013.8  8    4.1  6    5.7  8   12.0  010010  
20000503    31.3  8    28.7  8  1015.0  8  1013.8  8    6.0  6    
2.2  8    5.1  010010  20000504    32.3  8    29.8  8  1000.4  8   
999.2  8    2.4  5    8.3  8   13.0   
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 16. 3505 Delimited: 
 

   AWS  WBAN YR--MODAHRMN DIR SPD GUS CLG SKC L M H  VSB WW WW WW W 
TEMP DEWP    SLP   722280 13876 200301010053 140  11 ***  49 OVC * 
* * 10.1 00 ** ** *   59   54 1003.8 722280 13876 200301010153 140  
13 ***  25 OVC * * *  2.5 63 10 ** *   57   54 1003.7 722280 13876 
200301010253 170  14  21  14 OVC * * *  3.0 63 10 ** *   57   55 
1003.7 

 
 

5.6.3 Importing 
 
You use the NCDC plug-in after you have retrieved your NCDC data files. 
The file NCDC.jar must be located in the Plugins directory for HEC-
DSSVue.  You can import NCDC data by either dragging NCDC files 
with an extension of ".ncdc" from Windows Explorer and drop them into 
the main screen of HEC-DSSVue with an opened HEC-DSS file or by 
selecting NCDC from the Import menu under the Data Entry men 
 
To import NCDC data files into HEC-DSS: 
 
 1. Open your DSS file, from the Data Entry menu, point to Import, 

click NCDC.  An Open browser will open (Figure 5.36). 
 

 
Figure 5.36  Open Browser - Import NCDC Files 

 
 2. Navigate to the directory with your data file, select the file and 

then click Open. 
 3. The plug-in will read the file, parse the data and store it into the 

opened DSS file.  This process may take several seconds to 
complete, depending on the amount of data and speed of your 
machine. After the import is complete, a confirmation window will 
appear, see Figure 5.37 (page 5-33). 

 
Or, alternatively you can import NCDC files if they have the extension 
".ncdc" by: 
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Figure 5.37  Import NCDC File(s) Confirmation 

 
 1. From Windows Explorer, select the "ncdc" files that you wish to 

import. 
 2. "Drag" the files onto the main HEC-DSSVue screen (with your 

HEC-DSS file that you want to import to opened). 
 3. The data is imported and a message dialog will show how many 

values were stored. 
 
 

5.7 Retrieving and Importing CDEC Data 
 
You can optionally retrieve and import time-series data from the CDEC 
(California Data Exchange Center) database via the web using the CDEC 
plug-in tool.  It can retrieve a variety of hydro-meteorological and 
environmental data from CDEC for stations throughout the state of 
California.  You must enter the station information (station ID, sensor, 
duration code, and time window) manually into the plug-in table.  The 
plug-in has no capability to identify which stations and what data is 
available from CDEC.  Station ID and data availability can be obtained 
from the CDEC web site at:  http://cdec.water.ca.gov. 
 
To use the CDEC plug-in you must be connected to the internet and the 
file CDEC.jar must be located in the Plugins directory for HEC-DSSVue. 
 
 1. Open your DSS file, from the Data Entry menu, point to Import, 

click CDEC (Web), this will open the CDEC Download dialog 
box (Figure 5.38) with an empty station identifier table. 

 

 
Figure 5.38  CDEC Download Dialog Box 

 

http://cdec.water.ca.gov/�
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 2. You can either open a previously saved table or manually enter the 
station information for the stations that you want.  The CDEC 
plug-in cannot populate the table; you must manually enter the 
station information. 

 3. To open a previously saved table, select the File menu and then 
Open. Browse to the directory and file that you want to access and 
then press the Open button.  Optionally, you can select a file from 
the most recently used file list at the bottom of the File menu.  To 
save a table, select the File menu and then Save.  Browse to the 
directory where you want to save your table and then enter the file 
name and press the Save button.  Tables are in text format and are 
saved with an extension of ".cdec". 

 4. To manually enter station information, select the CDEC Station ID 
cell on a blank row.  Enter the ID and then fill in the basin or river 
name, location name and sensor number.  For each sensor, a 
default C part will be provided; you can change the C part, if 
desired.  Enter the duration code, which may be "Monthly", 
"Hourly", "Daily" or "Event".  The duration code must match the 
data set offered by CDEC for that location and sensor; it will not 
retrieve data that does not have that duration code. (You need to 
access the CDEC web site at http://cdec.water.ca.gov to determine 
what data sets are offered with what duration codes.)  A default F 
part of "CDEC" will be set but you can change that, if desired.  If 
you need to add additional rows, select the Edit menu and then 
Insert Rows.  Fill in the identifiers for any remaining stations that 
you want.  Once you have completed your table, save it using Save 
from the File menu. 

 5. You can sort the station table by pressing on the column header of 
the column that you want to sort by.  A second press of the column 
header will perform an inverse sort. 

 6. You can get a list of all sensor numbers, PE Codes and other 
information that CDEC has available by selecting Stations 
Definitions from the Options menu, as shown in Figure 5.39.  
These are the codes that CDEC uses, not necessarily what is 
available for each station. 

 

 
Figure 5.39  List of Station Definitions 

 

http://cdec.water.ca.gov/�
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 7. To retrieve data from the CDEC web site and import into HEC-
DSS, open or fill-in the station table as describe above, and then 
enter the start date and end date for the time frame that you want 
data for.  (The date boxes cannot be empty like they can for the 
USGS plug-in.)   The date should be entered in the form of 
DDMMMYYY (e.g., 03FEB2005).  Selecting the small box in the 
date field will provide a calendar tool to aid in setting the date.  
Even though you may specify dates, only data that is available 
within those dates from the web site can be retrieved.  You should 
check the CDEC web site (at http://cdec.water.ca.gov) to verify 
what data is available for the stations that you are interested in. 

 8. After the data type and time span have been set, select the stations 
from the table that you want data for by checking the box in the 
Get Data column for those stations.  If you want to retrieve data 
for all stations in your table, press the Select All button.  The data 
retrieval process will begin when you press the Get Data button.  
This operation will take some time, depending on your connection 
speed to the internet and how much data you have requested.  A 
Retrieve Progress dialog box will display the progress of the 
process.  After data has been retrieved, the main catalog screen in 
HEC-DSSVue will be automatically updated. 

 9. Monthly, daily and hourly data will be stored with an E part of 
"1MON", "1DAY", or "1HOUR", respectively.  Event data will be 
stored in an irregular-interval format with an E part of "IR-
MONTH".  You may want to use the interval modification 
functions available from the Time Functions tab in the Math 
Functions screen to change the data to a desired interval. 

 10. The CDEC plug-in currently has limited error detection 
capabilities.  If you think there are problems, you should check the 
HEC-DSSVue log screen for messages.  The log screen is usually 
minimized in your task bar.   

 
  The CDEC plug-in will indicate when data cannot be retrieved, but 

it may not give the reason why.  You should check the CDEC web 
page with a browser to ensure that what you are requesting is 
available.  The web address is:  http://cdec.water.ca.gov. 

 
 

5.8 Importing and Exporting DSSUTL Format 
 
You can import HEC-DSS data from the legacy DSSUTL program that 
was created using the "Write Data" WD command and export data from 
HEC-DSSVue to the DSSUTL "Write Data" format so that it can be read 
into DSSUTL with the "Read Data"  RD command.  Refer to the DSSUTL 
documentation for more information.  The function is supplied as a plug-in 
and the file Dssutl.jar must be located in the Plugins directory for HEC-
DSSVue. 
 

http://cdec.water.ca.gov/�
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An example of the data format from DSSUTL is: 
 

/MY BASIN/RIVERSIDE/FLOW/01MAY1990/1HOUR/OBS/ 
RTS  Ver: 44   Prog:GOES    LW:02JUN90  10:09:33   Tag:RIV-FLOW   Prec:0 
Start: 01MAY1990 at 0100 hours;   End: 04MAY1990 at 1200 hours;  Number:  108 
Units: CFS         Type: INST-VAL 
  13190.  13820.  14630.  15080.  15260.  15530.  15620.  15710.  15800. 
  15890.  15980.  14540.  14990.  15530.  15170.  14630.  14360.  14000. 
  13010.  12200.  11660.  11570.  11930.  11930.  11930.  12290.  12290. 
  12380.  12290.  12740.  13010.  12830.  12830.  13190.  14630.  14900. 
  13910.  13010.  11930.  10740.  10050.   9750.   9620.   9685.   9685. 
  10200.  10660.  10660.  10275.   9975.   9825.   9900.   9975.  10200. 
  10275.  10740.  11570.  11390.  10580.  10125.  10425.  10500.   9555. 
   8150.   9036.   9230.   9295.   9230.   9295.   9230.   9100.   9100. 
   9100.   8908.   9036.   9100.   9165.   9295.   9425.  10125.  10275. 
   9825.   9555.   9555.   9750.   9685.   9685.   9620.   9555.   9555. 
   9490.   9555.   9620.   9750.   9825.   9825.  10125.  10275.  10740. 
  11220.  11660.  12110.  12470.  12650.  12560.  12560.  12470.  12470. 
  END FILE 

 
 

5.8.1 Importing DSSUTL Data 
 
To import data from the DSSUTL format: 
 
 1. Open your DSS file, from the Data Entry menu, point to Import, 

click Dssutl Write Data File, the Enter DSSUTL data file to 
import browser will open (Figure 5.40). 

 

 
Figure 5.40  Selecting a DSSUTL Write Data File to Import 

 
 2. Select your file to import.  Data must be produced by the DSSUTL 

WD command. 



HEC-DSSVue User's Manual Chapter 5 – Data Entry, Import & Export 

5-37 

 3. Navigate to the directory with your data file, select the file and 
then click Open. 

 4. The plug-in will read the file, parse the data and store it into the 
opened DSS file.  This process may take several seconds to 
complete, depending on the amount of data and speed of your 
machine. 

 
 

5.8.2 Exporting Data to DSSUTL 
 
To export data from the DSSUTL format: 
 
 1. Select the pathnames for the data sets that you want to export, then 

from the Data Entry menu, point to Export , click Dssutl Write 
Data File. 

 2. A file selection browser will be displayed.  Navigate to the 
directory you wish to export the data to, type the name of file and 
Click Save.  All data will be saved in one file. 

 
 

5.9 Importing North Carolina DWR CRONOS Data 
 
The North Carolina Department of Water Resources developed a plug-in 
to import data from the CRONOS database into HEC-DSS.  This plug-in 
is supported by North Carolina DWR.  For questions, please contact them 
directly.  The web site is http://www.ncwater.org/wrisars/dss. 
 
The CRONOS Plug-in, developed by NC DWR, can search and retrieve 
the water and weather data for North Carolina and the surrounding states 
from NC Climate Retrieval and Observations Network of the Southeast 
Database (CRONOS) and store the data into a HEC-DSS file. The map 
and table search engine in Water Resources Information, Storage, 
Analysis, and Retrieval System (WRISARS) can be used with the 
CRONOS Plug-in to enhance the search capability.  An example of the 
NC DWR CRONOS Download dialog box is shown in Figure 5.41 (page 
5-38). 
 
To import data from CRONOS: 
 
 1. In HEC-DSSVue, create a new DSS file or open an existing one. 
 2. In the HEC-DSSVue main window, from the Data Entry menu, 

point to Import, click NC DWR CRONOS, as shown in Figure 
5.42 (page 5-38) the NC DWR CRONOS Download dialog box 
will Open (see Figure 5.41, page 5-38). 

http://www.ncwater.org/wrisars/dss�
http://www.ncwater.org/wrisars/ComprehensiveSearch.php�
http://www.ncwater.org/wrisars/ComprehensiveSearch.php�


Chapter 5 – Data Entry, Import & Export HEC-DSSVue User's Manual 

5-38 

 
Figure 5.41  NC DWR CRONOS Download Dialog Box 

 

 
Figure 5.42  Importing ND DWR CRONOS Data 

 
 3. From the NC DWR CRONOS Download dialog box (Figure 

5.41) from the Data Type list (Figure 5.43), select a data type for 
the data to be imported. 

 

 
Figure 5.43  Data Type Selection 

 
 4. Set the format for the data that is to be imported, from the NC 

DWR CRONOS Download dialog box (Figure 5.41), from the t a 
Data Table list (see Figure 5.44, page 5-39), select the data table 
style. 
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Figure 5.44  Data Table Selection 

 
 5. From the NC DWR CRONOS Download dialog box (see Figure 

5.41, page 5-38), click Get Stations by State, then select a state 
from the Select State list, or click Get Stations by HUC, and then 
select a HUC.  Click OK to search the stations and you will see the 
selected stations in the station table. 

 6. If you select Clear Stations, then the station table will be cleared 
when you select another group of stations. 

 7. If you want to do a more specific search, click Use WRISARS 
Search Tool, this will lead you to the WRISARS search page. 

 8. You can save the station table to a .cronos text file by from the 
File menu, click Save Station Table. 

 9. You can open a previously saved station table from an existing 
.cronos text file, from the File menu, click Open Station Table. 

 10. You can open a station table directly by clicking a file name (e.g. 
StationTableC.cronos) below the Close section from the File 
menu. 

 11. Select stations in the station table. 
 12. You can click the column title to sort the station table by that 

column, e.g. click Available End to sort by the available end 
timestamps. The columns in the table are shown in Figure 5.45. 

 

 
Figure 5.45  Column Header Titles 

 
 13. To select or unselect all the rows in the station table, click Select 

All or Unselect All, respectively. 
 14. You can delete the checked rows from station table, from the Edit 

menu, click Delete Checked Rows. 
 15. You can also add rows in front of the current row, from the Edit 

menu, click Insert Rows. 
 16. If you want to use the Station IDs for B parts, from the Edit menu, 

click Set B Part to Station ID. 
 17. If you want to use the station names for B parts, from the Edit 

menu, click Set B Part to Station Name.  The stations names are 
used for B parts by default. 

 18. If you just want to import a part of the data, then set up the Start 
Date and End Date, otherwise select Retrieve Period of Record.  

http://www.ncwater.org/wrisars/ComprehensiveSearch.php�
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(You can click Refresh Available Date to get the most accurate 
available dates information.)  See Figure 5.46 for an example of 
this toolbar. 

 
 

Figure 5.46  Setting the Time Window for Data Retrieval 
 
 19. Click Select Parameters and Import to open the Select 

Parameters window for the selected stations.  The descriptions for 
the parameters are shown on the right of the window.  By default, 
all parameters are selected.  Click Unselect All or Select, or you 
can select a few parameters manually.  If you select the upper 
checkbox in the All column, then the whole row will be selected 
automatically.  Click Import to import the data from the CRONOS 
database to the DSS file you just opened or created.  An example 
of the Select Parameters window is shown in Figure 5.47. 

 

 
Figure 5.47  Select Parameters Dialog Box 

 
 20. You can click Plot      , Tabulate      , or Tabulate in MS Excel to 

open the Select Parameters dialog box, select some parameters, 
and then import the data and show the data in a plot, table, or Excel 
directly. 

 21. From the View menu, click Tabulate, Plot, or Tabulate with 
Excel to import the selected station-parameters and show the data 
in a plot, table or Excel. 

 22. Examine the imported or updated data in HEC-DSSVue root 
window, table, plot, or Excel. 
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